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Important information
WARN ING

l Failure to follow the installation instructions shipped with your SMART product could result in
personal injury and damage to the product.

l Ensure that any cables extending across the floor to your SMART product are properly
bundled andmarked to avoid a trip hazard.

l Do not push foreign objects into the openings on your SMART product.

l Do not open or disassemble the SMART product. You risk electrical shock from the high
voltage inside the casing. Opening the casing also voids your warranty.

l The camera arm on your SMART product has joints that present a pinch hazard when you
move the camera arm. Keep clear of the pinch points.

l Do not stare into the lamp or shine the lamp directly into someone’s eyes. Turn off the lamp
when displaying or capturing images of people.

l Do not overload power outlets or extension cords as this can result in a fire or electric shock.

l Turn off and disconnect your SMART product before a thunderstorm. During a thunderstorm,
do not touch your SMART product or the power plug, because there is a risk of electrical
shock.

l To reduce the risk of fire or electric shock, do not expose the SMART product to rain or
moisture.

CAUTION

l Place your SMART product on a solid surface to prevent it from falling.

l If you have a security cable attached to your SMART product, do not carry or swing your
SMART product by the security cable.

l Do not connect non-shielded interface cables to your SMART product and do not leave
cables connected to unused connectors, because this can cause interference levels that
exceed FCC regulations.

l Avoid setting up and using the SMART product in an area with excessive levels of dust,
humidity and smoke.
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l Do not block or cover the openings or slots on your SMART product. These slots provide
ventilation, ensure reliable operation and protect your SMART product from overheating.

l Do not carry your SMART product by the camera arm. Carry it by the base of the unit.

l Disconnect your SMART product from the power outlet before cleaning it. Use a clean damp
cloth and do not use liquid or aerosol cleaners or solvents when cleaning your SMART
product.

l Only use your SMART product with the type of power source that is written on the power
supply and do not modify the plug.

l Do not aim the camera lens at the sun.

l If your SMART product requires replacement parts, make sure the service technician uses
replacement parts specified by SMART Technologies or parts with the same characteristics
as the original.

I M POR T A N T I N F ORMA T I ON
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Your SMART Document Camera™ 330 enables you to display 3D objects, printed documents and
microscope slides on your computer, projector or television. You can capture images and save them
to a SMART Notebook™ collaborative learning software file or to an SD or SDHC memory card.

Your document camera integrates with SMART Notebook software and SMART Board® interactive
whiteboards, creating an interactive presentation environment.

If you have amixed reality cube and SMART Notebook software 10.8 or later, you can use the cube
with your document camera tomanipulate 3D models in SMART Notebook files.

Chapter 1
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Document camera features

Camera
l High resolution 1.3MP CMOS sensor

l 5.2× optical zoom, 8× digital zoom

l Up to 30 frames per second

l Automatic or manual focus

l Microscopemode that doesn’t require adapters

Output
l SXGA, WXGA, 720p or XGA resolution

l DVI-D output

Physical construction
l Security lock slot

l Collapsible design for easy transport and storage

l Bright LED camera lamp

Software
l SMART Notebook software, including SMART Notebook 3D Tools andMixed Reality Tools

software

l SMART Product Drivers

l ImageMate® software

Image storage
l Supports memory cards with a built-in SD slot

l Supports USB memory sticks with a built in USB hub

l Supports image storage on connected computer

CHA PT ER 1
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Document camera views
Your document camera has three views you can use to control how it sends data to a computer,
projector or television.

l Computer view displays images from your document camera in a SMART Notebook file on
your computer.

l Camera view controls your document camera from the camera’s control panel and displays
images on a projector or television. You can also view images through SMART Notebook
software.

l SD Card view controls your document camera from the camera’s control panel and displays
images from amemory card on a connected projector or television.

SeeUnderstanding Computer, Camera and SD Card views on page 19 for more information on these
views.

Parts of the document camera

Adjustable camera arm and camera head
You can unfold and adjust the camera arm. You can also rotate the camera head to display objects at
a range of angles. The camera head has a zoom dial, an auto focus button and an LED light with a
light switch.

CHA PT ER 1
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Control panel
You can use the control panel to switch between Computer, Camera and SD Card view, capture an
image to amemory card and adjust brightness settings. You can also use it to control features and
settings in the Camera view or the SD Card view’s on-screen display menu.

NOTE

On some cameras, Camera view is represented by a symbol.

For information on views, seeUnderstanding Computer, Camera and SD Card views on page 19.

Rear connection panel
The rear connection panel has 12V DC, DVI-D Out, VGA Out, VGA In, Composite video out and
USB-B connectors.

CHA PT ER 1
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Side connection panel
The side connection panel has a security lock slot, an SD or SDHC memory card slot, a USB-A
connector, a switch for selecting VGA DVI-D or composite video output, and a switch to select either
SXGA, WXGA, 720p or XGA resolution.

NTSC/PAL switch
The NTSC/PAL switch is on the bottom of your document camera. This switch enables you to
change the format of composite video output for your television. SeeSwitching between NTSC and
PAL on page 15.

Mixed reality cube
With amixed reality cube, you can interact with 3D models in SMART Notebook
software usingMixed Reality Tools. SeeUsing SMART Notebook 3D Tools andMixed
Reality Tools on page 51.

Power supply
Your document camera comes with a power supply and a country-specific
power cable.

USB cable
Use the USB cable to connect your document camera to your computer. You can
display objects, capture images to SMART Notebook files and control your
document camera from SMART Notebook software.

CHA PT ER 1
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VGA cable
Use the VGA cable to connect your document camera to a projector or display. You
can display objects, capture images to amemory card and use the features in the
on-screen display menus.

Anti-glare sheet
Place the anti-glare sheet over printed documents to reduce glare.

Document camera software
Your document camera includes software downloads that will help you present images from your
document camera.

SMART Notebook software and SMART Product Drivers
Your document camera uses SMART Notebook software and
SMART Product Drivers. SMART Notebook software is presentation software
designed to work with SMART Document Cameras and the touch features of
SMART Board interactive whiteboards. In addition, if you have amixed reality cube,
you canmanipulate 3D models in SMART Notebook files usingMixed Reality Tools
(seeUsing SMART Notebook 3D Tools andMixed Reality Tools on page 51).

You can download SMART Notebook software and SMART Product Drivers at
smarttech.com/software.

You can find system requirements for your computer in theSMART Notebook software 10.8 release
notes (smarttech.com/kb/158853).

I MPORTANT

You need SMART Notebook software 10.8 or later to use SMART Notebook 3D Tools andMixed
Reality Tools.

CHA PT ER 1
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ImageMate software (Windows only)
You can use your document camera with ImageMate software. Visit the SMART download page at
smarttech.com/software to download ImageMate software.

CHA PT ER 1

Overview
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Basic connection 9
Setup configurations for Camera view and SD Card view 11
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Basic connection
Connect your SMART Document Camera to a power supply and your computer to use your
document camera with SMART Notebook software.

I MPORTANT

This configuration requires SMART Notebook software. To use Camera view or SD Card view,
connect your document camera directly to an external display.

Chapter 2
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g To connect the power supply

1. Connect the power supply cable to the 12V DC receptacle on the rear connection panel.

CAUTION

Ensure you connect the power cable to the power supply before connecting the power plug to
a power outlet.

2. Connect a country-specific power cable to the power supply, and then connect the plug to a
power outlet.

CHA PT ER 2
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g To connect your document camera to your computer

Connect the USB-B plug of your USB cable to your document camera, and then connect the USB-A
plug to your computer.

Setup configurations for Camera view and
SD Card view
After you complete the basic connection procedure (see page 9), you can connect your document
camera to an external display. This enables you to use the document camera in Camera view and SD
Card view (see page 19).

You can connect your computer and your document camera to different displays or they can share a
display.

CHA PT ER 2
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Connecting your document camera and computer to different displays
In this configuration your document camera images appear on one display, and your computer’s
desktop appears on the other display. You can also access document camera images through
SMART Notebook software on your computer.

g To connect your document camera and computer to different displays

1. Complete the basic connection steps (see page 9).

2. Connect your computer or laptop to the projector of an interactive display.

NOTE

This is the normal configuration for using interactive whiteboards.

3. Connect your document camera to another external display (see page 13).

Connecting your document camera and computer to a shared display
In this configuration your document camera is connected to your computer with both a USB and a
VGA cable. Your document camera is connected to an external display.

g To connect your document camera and computer to a shared display

1. Complete the basic connection steps (see page 9).

2. Connect your computer’s VGA Out port to your document camera’s VGA In port with a VGA
cable.

3. Connect your document camera to an external display with a VGA cable (see page 13).

NOTE

DVI-D or composite video displays will not display your computer view. A VGA display is
required.

This configurationmakes it easy to transition from Computer view to Camera view or SD Card
view using the same projector or display for all three views.

CHA PT ER 2
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Connecting your document camera to an
external display
You can connect your document camera directly to an external display to enable the following
functions:

l UseCamera view to view the camera image in full-screen on the external display.

l Use SD Card view to view a full-screen slide show on the external display.

l Access the Camera view’s or SD Card view’s on-screen display menu.

Connecting to a projector or flat-panel display
You can connect your document camera to a projector or a display with the VGA cable.

CAUTION

Ensure your projector or display is not connected to a power outlet when connecting it to your
document camera.

g To connect to a projector or display

1. Connect the VGA cable to theVGA Out connector on the back of your document camera.

2. Connect the other end of the VGA cable to the VGA In connector on your projector or display.

Switching between VGA DVI-D and Composite output
If you’re using a projector or computer display with a VGA or DVI-D cable, switch your document
camera to VGA DVI-D mode. If you’re using a television with the Composite video cable, switch your
document camera to Composite mode.

g To switch to VGA DVI-D mode

Switch theVGA DVI-D/Composite switch on the side panel toVGA DVI-D.

g To switch to composite mode

Switch the VGA DVI-D/Composite switch on the side panel toComposite.

CHA PT ER 2
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Connecting to a digital projector or HD display with DVI-D
You can connect your document camera to a digital projector or high-definition display using a DVI-D
single link cable.

CAUTION

Ensure your digital projector or display is not connected to a power outlet when connecting it to your
document camera.

NOTES

l Don’t use a DVI-I or DVI-A cable.

l You can use a DVI-D dual link cable, but it will function as a single link DVI-D.

l If you connect your document camera directly to a projector or high-definition display with a
DVI-D cable, you display only the camera image, and not your computer desktop or SMART
Notebook presentation.

g To connect to a digital projector or display

1. Connect a DVI cable from theDVI-D Out connector on your document camera to theDVI-D In
connector of your digital projector or high-definition display.

2. Switch to VGA DVI-D mode (see page 13).

Connecting to a television
You can connect your document camera to a television with a Composite video cable.

CAUTION

Ensure your television is not connected to a power outlet when connecting it to your document
camera.

g To connect to a television

1. Connect a Composite video cable from theComposite Out connector on your document
camera to theVideo In connector on your television.

2. Switch to Composite mode. SeeSwitching between VGA DVI-D and Composite output on the
previous page.

CHA PT ER 2
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Switching between NTSC and PAL
When you connect your document camera to a television, switch it to your television’s encoding
system (either NTSC or PAL).

g To switch between NTSC and PAL

Switch theNTSC/PAL switch on the bottom of your document camera toNTSC if your television
uses NTSC encoding, or toPAL if your television uses PAL encoding.

Setting output resolution
You can set your document camera’s output resolution tomatch the projector or display you’re using.

g To set the output resolution

Set theSXGA/WXGA/720p/XGA switch tomatch the resolution of your display. Refer to the chart
below to determine the output resolution you need.

Setting Resolution
SXGA 1280 × 1024
WXGA 1280 × 800
720p 1280 × 720
XGA 1024 × 768

Downloading software
Your document camera includes software downloads that you can use to createmore effective
presentations.

g To install SMART Notebook software and SMART Product Drivers

1. Go to smarttech.com/software.

2. Scroll toSMART Notebook collaborative learning software.

3. UnderChoose a version, select the latest version of SMART Notebook software for
Windows® orMac, and then follow the on-screen instructions.

CHA PT ER 2
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g To download and install Image Mate software

1. Visit the SMART download page at smarttech.com/software.

2. Scroll to ImageMate software for SMART Document Cameras.

3. UnderChoose a version, select Image Mate 2.0 software for SMART Document Camera
330, and then follow the on-screen instructions.

Activating SMART Notebook 3D Tools and
Mixed Reality Tools
SMART Notebook 3D Tools andMixed Reality Tools provide an intuitive way for students and
teachers to explore digital content with the SMART Document Camera.

When you connect your document camera to your computer, SMART Notebook 3D Tools andMixed
Reality Tools activate automatically. If you want to use SMART Notebook 3D Tools on a computer
that has never been connected to a document camera, you can activate SMART Notebook 3D Tools
by obtaining a product key and following the procedure below.

NOTE

You can obtain a product key for SMART Notebook 3D Tools by registering your document
camera’s serial number at smarttech.com/register.

g To activate SMART Notebook 3D Tools

1. ForWindows operating systems, select Start > All Programs > SMART Technologies >
SMART Tools > SMART Product Update.

For Mac OS X operating system software, browse to and double-click
Applications\SMART Technologies\SMART Tools\SMART Product Update.

TheSMART Product Update window appears.

2. Click Activate in theSMART Notebook row.

TheSMART Software Activation dialog box appears.

3. Click Add.

4. Type the product key you received from SMART in theProduct Key box, and then click Add.

5. Click license agreement, review the license agreement, and then click Close.

CHA PT ER 2
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6. If you accept the license agreement, select the I accept the terms in the license agreement
check box.

7. Click Next.

SMART Notebook 3D Tools activates.

8. Click Finish, and then close theSMART Product Update window.

CHA PT ER 2
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Understanding Computer, Camera and SD Card
views
You can use your SMART Document Camera in Computer, Camera and SD Card views. Each view
enables you to do different things and requires a specific connection to either a display, projector or
computer.

l Computer view

Connect your document camera to your computer with the included USB 2.0 cable, and then
set your document camera to Computer view to view document camera images only in
SMART Notebook software.

You can then save images to your SMART Notebook file for later presentation, or if your
computer is connected to an interactive whiteboard, projector or television, you can deliver your
SMART Notebook presentation with live images from your document camera.

SeeUsing your SMART Document Camera in Computer view on page 27.

Chapter 3
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l Camera view

Connect your document camera to a projector or television, and then set your document
camera to Camera view. You can then view full-screen images from your document camera
using a projector or high-definition display, even without a computer. You can still view images
through SMART Notebook software.

You can use the Camera view on-screen display menu for greater control of the image, using
Microscopemode, highlight boxes, screenmasks andmore.

SeeUsing your SMART Document Camera in Camera view on page 29.

l SD Card view

Connect your document camera to a projector or television, place an SD or SDHC memory
card in your document camera, and then set your document camera to SD Card view. You can
then view full-screen images and slide shows from thememory card directly on a projector or
high-definition display, even without a computer.

You can use the SD Card view’s on-screen display menu for greater control of the image, using
highlight boxes, screenmasks andmore.

SeeUsing your SMART Document Camera in SD Card view on page 43.

Identifying view features
The following table describes the differences between each view:

Feature description Computer
view

Camera
view

SD Card
view

View computer input (VGA In) Yes (VGA
Out only)

No No

View document camera image Yes (DVI-D
Out only)

Yes No

View pictures from amemory card No No Yes
Access memory card from computer with a USB cable Yes1 Yes1 Yes1

Control document camera from computer Yes2 Yes2 No
Capture to SMART Notebook or ImageMate software Yes2 Yes2 No
Capture to amemory card Yes2 Yes2 No
Access related on-screen display menu No Yes Yes

1. Onlywhen USB-Bmode is set toSD Storage. SeeSetting USB-BSD Storagemode on page 40.

2. Onlywhen USB-Bmode is set toApplication. SeeSetting USB-BApplicationmode on page 39.

CHA PT ER 3
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The following table describes outputs when your document camera is connected to a display with
VGA DVI-D or Composite VideoOut:

Feature description Computer
view

Camera
view

SD Card
view

Connect to projector or display (VGA Out) VGA In Camera
image

Memory card
images

Connect to high-definition projector or display (DVI-D
Out)

Camera
image

Camera
image

Memory card
images

Connect to television (Composite VideoOut) N/A Camera
image

Memory card
images

Setting document camera views

g To set Computer view

Press theComputer view button on the control panel. For more information, see page 27.

g To set Camera view

Press theCamera view button on the control panel. For more information, see page 30.

g To set SD Card view

Press theSD Card view button on the control panel. For more information, seeSetting your
document camera to SD Card view on page 43.

Performing basic operations
Use the following operations when your document camera is in any view.

Positioning your document camera
The camera arm unfolds and the camera head rotates so you can position your document camera to
display objects.

CHA PT ER 3
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g To unfold and position your document camera

1. Place a hand on the base of the document camera to stabilize it, and then pull the camera arm
upward and forward.

2. Rotate the camera head and aim the lens at your subject.

Turning you document camera on and off

g To turn your document camera on

Press thePower button on the control panel.

The power light turns from amber to flashing green. When the light becomes solid green, your
document camera is operational.

g To turn your document camera off

Press thePower button on the control panel.

The power light turns from green to amber.

Using the LED light
You can use the LED light on the camera head to illuminate your subject.

g To turn the LED light on

Switch the LED light switch to the left. SeeParts of the document camera on page 3.

CAUTION

Do not stare into the lamp or shine the lamp directly into someone’s eyes. Turn the light off when
displaying or capturing images of people.

Displaying printed documents
When you set your document camera to Computer view or Camera view, you can display printed
documents, use the anti-glare sheet to reduce glare, optimize the image for text documents with Text
modes and optimize the image for documents with graphics with Graphics modes.

CHA PT ER 3
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g To display printed documents

1. Place your documents on the table.

2. Adjust the document camera and aim its lens at your documents.

3. Rotate the zoom dial to adjust the zoommagnification.

4. Press theAuto Focus button to adjust the focus.

g To reduce glare with the anti-glare sheet

If glaremakes it difficult for you to read printed documents that you’re displaying, place the anti-glare
sheet on top of the printedmaterials.

g To optimize the image for text documents

1. When your document camera is in Camera view, press Menu on the control panel.

The on-screen display menu appears.

2. Select Image Setting, and then press Enter .

3. Select Image mode, and then press Enter .

4. Select either Text 1, Text 2 or Text 3, and then press Enter . SeeCamera view Image
Settings on-screen display menu on page 32 for an explanation of the settings.

g To optimize the image for documents with graphics

1. When your document camera is in Camera view, press Menu on the control panel.

The on-screen display menu appears.

2. Select Image Setting, and then press Enter .

3. Select Image mode, and then press Enter .

4. Select eitherGraphics 1 orGraphics 2, and then press Enter . SeeCamera view Image
Settings on-screen display menu on page 32 for an explanation of the settings.

Inserting and removing amemory card
Your document camera has amemory card slot, enabling you to save document camera images
(when your document camera is in Computer view or Camera view) or to display previously captured
images (when your document camera is in SD Card view).
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CAUTION

Avoid static electricity near amemory card because it can damage the card.

g To insert a memory card

1. Press theCamera view button on the control panel.

2. Insert a memory card into the card slot on the side panel.

I MPORTANT

o Set your document camera to Applicationmode (seeSetting USB-B Applicationmode
on page 39) if you want to capture images to thememory card.

o Ensure the label on thememory card is facing up.

g To remove a memory card

1. Press theCamera view button on the control panel and wait until your document camera
displays a live image.

2. Push in thememory card to eject it, and then remove the card.

CAUTION

To prevent memory card damage, do not remove thememory card while capturing or deleting
images.

Using your document camera with
SMART Notebook software
Your SMART Document Camera integrates with SMART Notebook software, enabling you to control
your document camera from your computer or from a SMART Board interactive whiteboard or display.
You can display objects, capture an image and your annotations on an image to a SMART Notebook
page, zoom, focus and adjust brightness settings.

NOTE

For information on using SMART Notebook 3D Tools andMixed Reality Tools, seeUsing
SMART Notebook 3D Tools andMixed Reality Tools on page 51.
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g To open a SMART Document Camera window

1. Connect your SMART Document Camera to your computer and turn on the document camera.

2. Place the object or objects you want to display under the camera.

3. Press SMART Document Camera .

A SMART Document Camera window appears.

NOTE

Alternatively, you can open the SMART Document Camera window by pressingCapture
on the SMART Document Camera control panel.

4. Do any of the following:

o Press Zoom In to zoom in.

o Press Zoom Out to zoom out.

o Press Increase Brightness to brighten the image.

o Press Decrease Brightness to darken the image.

o Press Focus In or Focus Out to change the focus manually.

o Press Autofocus to change the focus automatically.

5. Press Closewhen you’re done.

CHA PT ER 3

Using your SMART Document Camera

25



g To convert the image

1. Open a SMART Document Camera window.

2. Press Additional Settings .

3. Do any of the following:

o Select Rotate 180 Degrees to rotate the image 180°.

o Select Convert to Color to convert a black and white image to color.

o Select Convert to Black and White to convert a color image to black and white.

o Select Convert to Positive to convert a negative image to positive.

o Select Convert to Negative to convert a positive image to negative.

g To use Microscope mode

1. Open a SMART Document Camera window.

2. Press Additional Settings , and then select Start Microscope Mode.

3. When you’re done, press Additional Settings , and then select Stop Microscope Mode.

g To take a screen capture

1. Open a SMART Document Camera window.

2. Press Capture and Close to insert a screen capture on the current page and close the
window.

OR

Press Capture to New Page to insert a screen capture on a new page and keep the
window open.

g To take a series of screen captures

1. Open a SMART Document Camera window.

2. Press Capture with Time-Lapse , and then select a period of time. (For example, if you
want to take a screen capture every 15 seconds, select 15 Seconds.)

3. Press when you’re done.
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Chapter 4: Using your
SMART Document Camera in
Computer view
Setting Computer view 27
Using Computer view 28

This view is for presenting images from your SMART Document Camera through your
SMART Notebook software or ImageMate software. Connect your computer to both your document
camera and your projector, and then set your document camera to Computer view.

The interactive whiteboard or projector displays your computer desktop or SMART Notebook file, and
you can view or capture images from the camera.

Computer view is accessible in all computer, projector and document camera setup configurations.

Setting Computer view
I MPORTANT

Your document cameramust be in Applicationmode. SeeSetting USB-B Applicationmode on
page 39.

g To set Computer view

1. Ensure your document camera is connected to your computer with the included USB 2.0 cable.

2. Ensure your computer is connected to a projector or a display.

3. Press theComputer view button on the control panel.
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Using Computer view
Computer view enables you to bring images from your document camera into SMART Notebook
software.

g To use Computer view

Refer toUsing your document camera with SMART Notebook software on page 24.
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Chapter 5: Using your
SMART Document Camera in
Camera view
Setting Camera view 30
UsingMicroscopemode 31
Using the Camera view’s on-screen display menu 31

Camera view Image Settings on-screen display menu 32
Camera view Special Tools on-screen display menu 34

Using the highlight feature 34
Using imagemasks 36
Using the scroll feature 36
Using the Picture in Picture (PiP) feature 37

Camera view Function Settings on-screen display menu 38
Setting USB-B mode 39
Setting USB-B Applicationmode 39
Setting USB-B SD Storagemode 40

Saving images to amemory card 40
Capturing images to amemory card 40
Transferring images from amemory card to your computer 41

Connect your SMART Document Camera to an external display to see a full-screen image from your
document camera.

You can use your document camera in Camera view to perform the following tasks:

l Display objects

l Capture images to an SD or SDHC memory card

l Capture images to SMART Notebook or ImageMate software

l Use the features and settings in the on-screen display menu
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l UseMicroscopemode to use your document camera with a standardmicroscope eyepiece
without additional adapters

Setting Camera view
Switch your document camera to Camera view to display images on a projector, flat-panel display or
television.

I MPORTANT

Your document cameramust be connected directly to an external display. SeeConnecting your
document camera to an external display on page 13.

g To switch to Camera view

1. Connect your document camera to a projector or flat-panel display with the appropriate cable
(seeConnecting your document camera to an external display on page 13).

2. Press theCamera view button on the control panel.

g To display objects

1. Press thePower button on the control panel.

2. Press theCamera view button on the control panel.

3. Place the object you want to display under the camera.

4. Rotate the camera head to aim the lens at your subject.

g To adjust the zoom magnification

Rotate the zoom dial on the camera head to increase or decrease the zoommagnification.

g To automatically adjust the focus

Press theAuto Focus button on the camera head to automatically focus the image.

g To adjust brightness settings

Press theBrighten or theDarken button on the control panel.
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Using Microscope mode
The SMART Document Camera enables you to view themicroscope stage through the document
camera without additional attachments.

g To display a microscope slide

1. Place a slide or object on the stage of themicroscope.

2. Focus themicroscope so that the subject is in sharp focus.

3. Position themicroscope under your document camera so the camera lens is aligned with the
microscope eyepiece.

CAUTION

Ensure you do not hit your document camera lens with themicroscope. This could damage
your document camera’s lens.

4. Press theCamera view button on the control panel.

5. Press Menu on the control panel.

6. Select the Image Settingmenu.

7. Use the up and down arrow buttons to selectMicroscope mode, and then press Enter .

8. Use the up and down arrow buttons to select On, and then press Enter .

Using the Camera view’s on-screen display
menu
You use the on-screen display menu to adjust several settings for your document camera.

g To open the Camera view’s on-screen display menu

1. Set your document camera to Camera view.

2. Press theMenu button on the control panel.

The on-screen display menu appears.

3. Press the up and down arrow buttons on the control panel to navigate to amenu item.

4. Press the left and right arrow buttons to navigate forward or backward throughmenu items.

5. Press Enter to select amenu item.
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6. To return to the previous menu level, use the down arrow button to navigate toBack , and
then press Enter .

OR

To exit themenu, press Menu.

The following on-screen display menu options are available when your document camera is in
Camera view:

Menu Options
Image Settings Brightness, Reset Brightness, Auto focus, Focus, Shutter

Speed, White Balance, R/B-Gain, Imagemode, Edge Effect,
Gamma, Image Rotation, Microscopemode, Color/B&W and
Positive/Negative. SeeCamera view Image Settings on-screen
display menu below.

Special Tools Highlight, Mask, Scroll and Picture in Picture. SeeCamera view
Special Tools on-screen display menu on page 34.

Function Settings USB-B mode, Frequency, Save Settings, Load Settings, Menu
Display and Language. SeeCamera view Function Settings on-
screen display menu on page 38.

Camera view Image Settings on-screen displaymenu

g To access the Image Settings menu

Select Camera view > Menu > Image Settings .

Image Settings menu options Description

Brightness
l Auto Adjusts image brightness automatically

l Manual Allows you tomanually adjust image brightness

Reset Brightness1

l Yes Resets image brightness

l No Cancels resetting

AF mode

l Push Sets the focus when you press theAuto Focus button

l Zoom Sync Automatically sets the focus when you adjust the zoom

Focus Allows you tomanually adjust focus
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Image Settings menu options Description

Shutter Speed
l Slow Sets a slow shutter speed, resulting in a brighter image, but with

more blur

l Fast Sets a fast shutter speed, resulting in a darker image, but with
less blur

White Balance
l Auto Sets white balance automatically

l One-Push Sets white balance when you press theAuto Focus
button

l Manual Allows you tomanually set theWhite Balance, using red grain
and blue grain

R-Grain2 Manually sets red grain

B-Grain2 Manually sets blue grain

Image mode
l Text 1

l Text 2

l Text 3

Optimizes image for displaying text documents by emphasizing
contrast. Setting is low at Text 1 and high at Text 3.

l Graphics 1 Optimizes image for displaying graphics. Displays Edge Effect
andGamma icons.

l Graphics 2 Optimizes image from DLP projector

Edge Effect3 Emphasizes image outlines. Set to Low, Middle or High.

Gamma3 Sets Gamma for the image. Set to Low, Middle or High.

Image Rotation
l Off Displays normal image rotation

l On Rotates image 180°

Microscope mode
l On Turns onMicroscopemode

l Off Turns off Microscopemode

Color/B&W
l Color Displays color images

l B&W Displays black and white images

Positive/Negative
l Positive Displays normal image

l Negative Displays film negative image
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1. Visible only when Brightness is set to Auto

2. Visible only whenWhite Balance is set to Manual

3. Visible only when Imagemode is set to Graphics 1

Camera viewSpecial Tools on-screen displaymenu

g To access the Special Tools menu

Select Camera view > Menu > Special Tools .

Special Tools menu options Description

Highlight
l Highlight On

l Adjust Transparency

l Adjust Size

Highlights a center square on the displayed image

Mask
l Mask On

l Adjust Transparency

Covers the displayed image with an adjustable screenmask

Scroll
l Scroll on

l ×2

l ×3

l ×4

Zooms in on the displayed images and enables you tomove the
zoomed area with the up, down, left and right arrow buttons on
the control panel

PiP Takes a picture, and then displays that picture in a corner of the
screen while youmove or zoom the camera

Using the highlight feature
When you use the highlight feature, a square in the center of the displayed image highlights your
subject. You can change the size, transparency and position of the highlight square.

NOTE

The highlight feature is for display purposes only. If you capture an image while the highlight square
is on, the image doesn’t include the highlight.
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g To use the highlight feature

1. Display an object in Camera view, and then press Menu on the control panel.

The on-screen display menu appears.

2. Press the up and down arrow buttons to select Special Tools , and then press Enter .

3. Use the up and down arrow buttons to select Highlight > Highlight On, and then press Enter
.

Your document camera highlights a square in the center of the image and obscures the edges
of the image.

g To move the highlight square

Use the up, down, right and left arrow buttons tomove the highlight square.

g To change highlight transparency

1. Press Menu.

The on-screen display menu appears.

2. Press the up and down arrow buttons to select Special Tools , and then press Enter .

3. Press the up and down arrow buttons to select Highlight On, and then press Enter .

4. Press the up and down arrows to select Highlight transparency.

5. Press Enter to save your settings.

g To change the highlight area size

1. Press theMenu button on the control panel.

The on-screen display menu appears.

2. Press the up and down arrow buttons to select Special Tools , and then press Enter .

3. Press the up and down arrow buttons to select Highlight, and then press Enter .

4. Select Adjust size, and then press Enter .

5. Press the up, down, left and right arrow buttons to change the highlight area size.

6. Press Enter to save your settings.

g To turn off the highlight feature

Press Enter .
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Using image masks
Imagemasks obscuremost of the image. You can resize or move themask to reveal more of the
image.

NOTE

The imagemask feature is for display purposes only. If you capture an image while the image mask
is on, the image doesn’t include the imagemask.

g To use an image mask

1. Display an object in Camera view, and then press Menu on the control panel.

The on-screen display menu appears.

2. Press the up and down arrow buttons to select Special Tools , and then press Enter .

3. Press the up and down arrow buttons to selectMask on, and then press Enter .

An imagemask appears on the image.

g To move the image mask

Press the up, down, right and left arrow buttons tomove themask area.

g To change image mask transparency

1. Press Menu.

The on-screen display menu appears.

2. Press the up and down arrow buttons to select Special Tools , and then press Enter .

3. Press the up and down arrow buttons to select Image Mask Transparency, and then press
Enter .

4. Press the up and down arrows to select Adjust transparency.

5. Press Enter to save your settings.

g To turn off an image mask

Press Enter .

Using the scroll feature
The scroll feature zooms in on the image and allows you tomove the zoomed area with the arrow
buttons.

CHA PT ER 5

Using your SMART Document Camera in Camera view

36



NOTE

The scroll feature is for display purposes only. If you capture an image while the scroll is on, the
captured image is the unscrolled image.

g To display the scroll feature

1. Display an object in Camera view, and then press Menu on the control panel.

The on-screen display menu appears.

2. Press the up and down arrow buttons to select Special Tools, and then press Enter .

3. Press the up and down arrow buttons to select Scroll, and then press Enter .

4. Press the up and down arrow buttons to select Scroll On, and then press Enter .

Your document camera displays a zoomed area of the image.

g To move the zoomed scroll area

Use the up, down, right and left arrows tomove the zoomed scroll area.

g To change the scroll area magnification

When setting the scroll feature, select either ×2, ×3 or ×4, and then press Enter .

Using the Picture in Picture (PiP) feature
The Picture in Picture (PiP) feature captures a temporary image from your document camera, and
then displays it in one corner of the display. You can then change what is under the camera without
the temporary image changing.

NOTE

The PiP feature is for display purposes only. If you capture an image while the PiP is on, the image
doesn’t include the PiP.

g To display the PiP image

1. Display an object in Camera view, and then press Menu on the control panel.

The on-screen display menu appears.

2. Press the up and down arrow buttons to select Special Tools, and then press Enter .

3. Press the up and down arrow buttons to select PiP, and then press Enter .

Your document camera displays a picture in picture image.
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g To move the PiP image

When displaying the PiP image, press the up, down, left and right arrow buttons on the control panel
to move the image.

g To turn off the PiP setting

Press Enter on the control panel.

Camera view Function Settings on-screen displaymenu

g To access the Functions Settings menu

Select Camera view > Menu > Function Settings .

Function Settings menu
options

Description

USB-B mode
l SD Storage Allows you to copy or view your memory card from your

computer. SeeSetting USB-B SD Storagemode on page 40.

l Application Use SMART Notebook software to control your document
camera, andmore. SeeSetting USB-B Applicationmode on the
next page.

Frequency
l 60 Hz Sets frequency at 60 Hz

l 50 Hz Sets frequency at 50 Hz

Save Setting
l 1 Saves presets for setting 1

l 2 Saves presets for setting 2

l 3 Saves presets for setting 3

l 4 [Power On] Saves presets for when you turn your document camera on

l Cancel Cancels preset save

Load Setting
l 1 Loads preset 1

l 2 Loads preset 2

l 3 Loads preset 3

l Default Loads default settings

CHA PT ER 5

Using your SMART Document Camera in Camera view

38



Function Settings menu
options

Description

l 4 [Power On] Loads preset for when you turn your document camera on

l Cancel Cancels load setting

Menu Display
l On Turns onmenu display

l Off Turns off menu display

Language
l English Sets language to English

l Français Sets language to French

l Deutch Sets language to German

l Español Sets language to Spanish

Setting USB-B mode
USB-B mode sets how your document camera, your computer and amemory card interact.

g To access the USB-B mode setting

Select Camera view > Menu > Function Settings > USB-B mode .

Action SD Storage
mode

Application
mode

See thememory card from your computer Yes No
View and use your document camera from
SMART Notebook or ImageMate software

No Yes

Capture image to thememory card in both Computer view
and Camera view

No Yes

SD Card view menu includes SD Settings No Yes

Setting USB-B Application mode
To use your document camera with your computer, youmust set it to Applicationmode in the Camera
view on-screen display menu.

I MPORTANT

Your document cameramust be in Camera view to set it to Applicationmode. It cannot be in
Computer view or SD Card view.
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g To set your document camera to Application mode

1. Connect your document camera to a projector or flat-panel display with the VGA cable (see
page 13).

2. Turn on your computer, and set it to Camera view.

3. Press Menu on the control panel.

The on-screen display menu appears.

4. Press the up and down arrow buttons on the control panel to select Function Setting, and then
press Enter .

5. Select USB-B mode, and then press Enter .

6. Select Application and then press Enter .

Setting USB-B SD Storage mode
This mode enables you to see the contents of your memory card from your computer.

g To set SD Storage mode

1. Connect your document camera to a projector, flat-panel display or television (see page 13).

2. Press Menu on the control panel.

The on-screen display menu appears.

3. Press the up and down arrow buttons on the control panel to select Function Setting, and then
press Enter .

4. Select USB-B mode, and then press Enter .

5. Select SD Storage and then press Enter .

Saving images to a memory card
You can capture images to amemory card when your document camera is in Camera view.

Capturing images to amemory card

g To capture images to a memory card

1. Set your document camera to Camera view. SeeSetting Camera view on page 30.

2. Position your document camera.
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3. Make any camera settings you require using the Camera view’s on-screen display menu.

4. Press theCapture button on the document camera control panel.

The camera capture icon appears, indicating that a photo is being taken.

I MPORTANT

If you do not see the camera capture icon, ensure your document camera’s USB-B mode is
set to Application. SeeSetting USB-B Applicationmode on page 39.

Transferring images from amemory card to your computer
You can transfer images from amemory card to your computer.

g To transfer images to your computer

1. Set your document camera to SD Storagemode. SeeSetting USB-B SD Storagemode on the
previous page.

2. Connect your document camera to your computer with the USB cable (seeBasic connection
on page 9).

Your computer recognizes your document camera andmemory card as a removable disk.

3. Browse to the removable disk on your computer, and then transfer the images to your
computer.
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Using the SD Card view display 44
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Showing slideshows 49
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When you set your SMART Document Camera to SD Card view, your document camera acts as an
SD or SDHC memory card reader, displaying previously captured images either individually or as a
slide show. Your computer isn’t used in an SD Card presentation.

Setting your document camera to SD Card view

g To set SD Card view

1. Ensure your document camera is connected directly to a projector or another display. For
connection information, see page 11.

2. Insert a memory card in your document camera.

3. Press theSD Card view button on the control panel.
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Using the SD Card view display

g To display images

1. Press theSD Card view button on the control panel.

2. Use the left and right arrow buttons on the control panel to scroll through images on thememory
card.

g To display and select thumbnail images

1. Press theSD Card view button on the control panel.

2. Press Enter to display up to 16 thumbnail-sized images.

g To return to displaying single images

Press Enter to display a single image.

Using the SD Card view on-screen display menu
The SD Card view’s on-screen display’s menu enables you to use the document camera as a
memory card reader.

SDCard view’s on-screen displaymenu options
The following on-screen display menu options are available when your document camera is in SD
Card view.

Menu Options
SD Settings Delete, Lock, Unlock and Format Media. SeeSetting USB-B

Applicationmode on page 39.
Your document camera’s USB-B modemust be set to Application to
see this menu. SeeSD Settings on-screen display menu on the next
page.

Special Tools Highlight, Mask and Scroll. SeeSpecial Tools on-screen display
menu on page 48.

Slide Show Start Slideshow, Interval, Select, Repeat andOrder. SeeSlideshow
Settings on-screen display menu on page 49.
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SDSettings on-screen displaymenu

g To access the SD Settings menu

Select SD Card view > Menu > SD Settings .

I MPORTANT

The SD Settings are available only if you have your document camera set to Applicationmode in
the Camera view on-screen display menu. SeeSetting USB-B Applicationmode on page 39.

SD Settings menu options Description

Delete
l Current Deletes current image

l All Deletes all images in the current folder

l Cancel Cancels image delete

Lock
l Current Locks current image

l All Locks all images

l Cancel Cancels image lock

Unlock
l Current Unlocks current image

l All Unlocks all images

l Cancel Exits Unlock settings

Format Media
l No Cancels memory card formatting

l Yes Formats memory card
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Deleting images from a memory card
You can delete images from amemory card in your document camera using the on-screen display
menu.

I MPORTANT

l Your document cameramust be set to Applicationmode. SeeSetting USB-B Application
mode on page 39.

l You are unable to delete images from your computer, only from the document camera’s
memory card.

g To delete images

1. Press theSD Card view button on the control panel.

You see the current saved image from thememory card.

2. Use the left and right arrow buttons on the control panel to select the image you want to delete.

3. Press Menu on the control panel.

The on-screen display menu appears.

4. Select SD, and then press Enter .

5. Select Delete, and then press Enter .

6. Select Current, and then press Enter to delete the current image.

OR

Select All, and then press Enter to delete all images in the viewed folder.

The deleting image icon displays briefly while your document camera deletes images.

Locking and unlocking images
You can lock images to include them in slideshows set toSelect > Lock in the Slideshow menu.

I MPORTANT

If you are unable to access the SD Menu, youmust set your document camera’s USB-B mode to
Application. This is a Camera view menu setting. SeeSetting USB-B Applicationmode on page
39.
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g To lock images for a slideshow

1. Press theSD Card view button on the control panel.

2. Use the arrow buttons on the control panel to select the image you want to lock, and then press
theMenu button.

The on-screen display menu appears.

3. Select SD > Lock, and then press Enter .

4. Select Current, and then press Enter .

OR

Select All to lock all images.

Repeat steps 1 to 3 to lock other images for your slideshow.

g To unlock images for a slideshow

1. In SD Card view, use the arrow buttons on the control panel to select the image you want to
unlock, and press theMenu button.

The on-screen display menu appears.

2. Select SD > Unlock, and then press Enter .

3. Select Current, and then press Enter .

OR

Select All to unlock all images.

Repeat steps 1 to 3 to unlock other images for your slideshow.
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Special Tools on-screen displaymenu

g To access the Special Tools menu

Select SD Card view > Menu > Special Tools .

Special Tools menu options Description

Highlight
l Highlight On

l Adjust Transparency

l Adjust Size

Highlights a center square on the displayed image

Mask
l Mask On

l Adjust Transparency

Covers the displayed image with an adjustable screenmask

Scroll
l Scroll on

l ×2

l ×3

l ×4

Zooms in on the displayed images and enables you tomove the
zoomed area with the up, down, left and right arrow buttons on
the control panel

The SD Card view’s Special Tools menu includes the same tools as the Camera view’s Special
Tools menu, except that the SD Card view doesn’t have the Picture in Picture (PiP) feature.

l For information on how to use the Highlight feature, seeUsing the highlight feature on page 34.

l For information on how to use theMask feature, seeUsing imagemasks on page 36.

l For information on how to use the Scroll feature, seeUsing the scroll feature on page 36.
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SlideshowSettings on-screen displaymenu

g To access the Slideshow Settings menu

Select SD Card view > Menu > Slideshow .

Slideshow menu options Description

Start Slideshow Starts a slideshow of images

Interval
l 5 sec Sets image interval to 5 seconds

l 10 sec Sets image interval to 10 seconds

l 15 sec Sets image interval to 15 seconds

l 30 sec Sets image interval to 30 seconds

Select
l All Selects all images for slideshow

l Lock Sets so only locked images display in a slideshow

Repeat
l Off Turns off slideshow repeat

l On Turns on slideshow repeat

Order
l Forward Sets slideshow order to forward

l Backward Sets slideshow order to backward

Showing slideshows

g To start a slideshow

1. Access the Slideshow menu.

2. Select Slideshow, and then press Enter .

3. Select Start Slideshow, and press Enter .

Your document camera displays a slideshow of images on thememory card.

g To stop a slideshow

Press Enter or any of the arrow buttons on the control panel.

The image slideshow stops and the on-screen display menu appears.

CHA PT ER 6

Using your SMART Document Camera in SD Card view

49



Displaying specific images in a slideshow
You can set your document camera to display only images that you select.

g To set SD settings to display selected images only

1. In SD Card view, press Menu on the control panel.

The on-screen display menu appears.

2. Select Slideshow > Select, and then press Enter .

3. Select Lock, and then press Enter so that only locked images display in a slideshow.

I MPORTANT

When you set the slideshow to Lock, it will include only images that are locked. You lock
images in the SD Card view’s SD menu, not the Slideshow menu.

g To lock images

See Locking and unlocking images on page 46.

g To unlock images

See Locking and unlocking images on page 46.
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Chapter 7: Using SMART Notebook
3D Tools and Mixed Reality
Tools
Incorporating 3D content into your lessons 52
Getting started 52

Hardware and software requirements 52
Lighting requirements 53

Using themixed reality mat 53
Inserting andmanipulating 3D models 56

Inserting 3D models 56
Manipulating 3D models 57

Rotating a 3D model 57
Pausing, playing and restarting animation 58
Adding labels 59

Navigating 3D scenes 60
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Your SMART Document Camera can transform any classroom or lecture hall into a spontaneous and
interactive learning environment. It uses a high-resolution video camera to display clear and detailed
images of writtenmaterial or any physical object.

SMART Notebook 3D Tools andMixed Reality Tools take this experience to a new level by providing
teachers and students with a new way to engage with digital 3D content.

This chapter provides the information you need to begin using SMART Notebook 3D Tools andMixed
Reality Tools with your SMART Document Camera as well as SketchUp™ sketching software and
Google™ 3D Warehouse.
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SMART Notebook 3D Tools andMixed Reality Tools provide an intuitive way for students and
teachers to explore digital content with the document camera. This technology is integrated with
SMART Notebook software.

Incorporating 3D content into your lessons
You can incorporate 3D content into your SMART Notebook software lessons. The following are
examples of how to do this:

l If you’re teaching a biology lesson, insert a 3D model of a heart into your .notebook file. Rotate
and change the size of the 3D model to present the different parts of the heart.

l If you’re teaching an English lesson, insert a 3D model of a city that is referenced in a novel the
class is reading. Enter the 3D scene to navigate streets and interiors of buildings.

l If you’re teaching a primary lesson, insert multiple 3D models and use theDisguise feature to
reveal answers as amemory exercise.

Getting started

Hardware and software requirements
To get started with Mixed Reality Tools, you need the following:

l SMART Notebook software 11

l SMART Document Camera 330

l A mixed reality cube

l AWindows computer meeting the following requirements:

o Pentium® 4 processor or better

o 512MB of RAM (1 GB recommended)

o 2GB of free hard disk space

o Windows XP SP3, Windows Vista® SP2 orWindows 7 operating system

o DirectX® 9 compatible graphics hardware
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l A Mac computer meeting the following requirements:

o 1.5 GHz Intel® processor or better

o 1GB of RAM

o 1GB of free hard disk space for minimum installation (2 GB for full installation with
Gallery collections)

o Mac OS X 10.6 operating system software or later

Lighting requirements
Mixed Reality Tools works best in a bright room where the work surface doesn’t have any noticeable
shadows or glare.

The light must be as uniform as possible, shining on the cube and background. You can achieve this
by setting up the document camera so that the camera is facing directly down, perpendicular to a
uniform, neutral work surface. The work surface should not be darker than the black elements on the
mixed reality cube or lighter than the white elements on the cube.

NOTES

l In very bright rooms, the work surface can appear whiter than the white elements on the
cube.

l You can print a mixed reality mat and place it under the document camera to increase
contrast between the cube and the background (seeUsing themixed reality mat below).

A typical projector room is usually quite dark. For Mixed Reality Tools to work properly, the document
camera’s light should be turned on. Don’t manipulate the cubemore than 14" (35 cm) from the
document camera.

NOTE

If SMART Notebook software doesn’t enter Mixed Reality mode when you hold the cube under the
camera, shake the cube under the camera. If the issue persists, press and hold the brighten button
on the document camera tomaximize the brightness.

Using the mixed reality mat
To increase the contrast between themixed reality cube and background, you can use themixed
reality mat available from the SMART Support website. Themat includes marks that indicate the area
in which you canmove the cube while in Mixed Reality mode.
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To print themixed reality mat, you need the following items:

l A computer with Internet access and Adobe® Reader® or Acrobat® software.

l A printer

l Tape

g To print the mixed reality mat

1. Open the appropriate mixed reality mat file in Adobe Reader or Acrobat.

Region Page size Link
U.S. and Canada Letter (8 1/2" × 11") smarttech.com/kb/160487
Elsewhere A4 smarttech.com/kb/160488

2. Select File > Print.

ThePrint dialog box appears.

3. Select None in thePage Scaling drop-down list, clear theAuto-Rotate and Center check
box, and then press OK.

4. Arrange the pages:

o Page 1 is top left.

o Page 2 is top right.

o Page 3 is bottom left.

o Page 4 is bottom right.

Set page 1 as the bottom page in your stack.

5. Overlap, orient and align the pages according to the guidelines, and then tape the pages
together.

NOTE

Due to different page sizes and printing options, your pages may not align perfectly onto the
guidelines. If that is the case, align the pages to the central crosshairs.

T I PS

o Use a light table or a tablet device set to a white background as an aid when aligning
the pages.

o Tomake themat last longer, consider printing it on heavy cardstock.
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g To use the mixed reality mat

1. Place themixed reality mat on your work surface.

2. Place the document camera over the darkened area on themat.

3. Rotate the bottom arm of the document camera so that it’s 90° from your work surface.

4. Rotate the upper arm of the document camera upward until it’s at its highest spot, ensuring the
bottom arm is still set to 90°.
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5. Turn on the document camera.

NOTES

o The document camera image should show the target area in the center. You can adjust
themat slightly if necessary.

o The lines on themat indicate where you can position themixed reality cube while in
Mixed Reality mode (seeManipulating 3D models usingMixed Reality Tools on page
62).

Inserting and manipulating 3D models
To use SMART Notebook 3D Tools software, you need to insert a 3D model in your .notebook file.
After you insert a 3D model, you canmanipulate it in the sameway youmanipulate other objects in
SMART Notebook software.

NOTE

You can insert 2D images and 3D models on the same page andmanipulate them the sameway
youmanipulate other objects in SMART Notebook software.

Inserting 3Dmodels
3D models are available from the 3D Objects folder in Lesson Activity Examples and the
SMART Exchange™website (exchange.smarttech.com) as well as the Google 3D Warehouse (see
UsingGoogle 3D Warehouse on page 66). You can also insert your own 3D models if they are in one
of the following formats:

l COLLADA (.dae)

l 3D Object (.obj)

l FBX (.fbx)

NOTE

Textures and other information for some 3D models are stored in separate files and folders. When
you insert these 3D models, ensure the 3D model file is located in the correct folder structure with
the supporting files and folders.

g To insert a 3D model

1. Select Insert > 3D File.

The Insert 3D File dialog box appears.
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2. Browse to and select the 3D model you want to insert.

3. Press Open.

The 3D model appears on the page.

Manipulating 3Dmodels
After inserting a 3D model, you canmanipulate it in the sameway youmanipulate other objects in
SMART Notebook software. In particular, you can do the following:

l Cut, copy and paste

l Clone

l Move

l Scale

l Lock

l Attach links and sounds

l Add to the Gallery tab

NOTES

l For information on these basic options, see the Help for SMART Notebook software.

l When you add a 3D model to the Gallery tab, it appears in the 3D Objects category.

In addition to these basic options, you can do the following:

l Rotate the 3D model

l Pause, resume, play and restart animation

l Add labels

Rotating a 3D model
You can rotate a 3D model alongmultiple axes. After rotating a 3D model, you can reset it to its
original orientation.

g To rotate a 3D model along a single axis

1. Select the 3D model.

2. Press and hold one of the side rotation handles.
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3. Drag your finger around the center of the 3D model, and then release your finger when done.

g To rotate a 3D model along multiple axes

1. Select the 3D model.

2. Press and hold the center rotation handle.

3. Drag your finger in the direction you want to rotate the 3D model, and then release your finger
when done.

g To reset a 3D model to its original orientation

1. Select the 3D model.

2. Press the 3D model’s menu arrow, and then select Reset Rotation.

Pausing, playing and restarting animation
If a 3D model contains animation, you can pause, resume and restart the animation.

NOTE

If a 3D model doesn’t contain animation, theAnimation menu documented in the following
procedures is disabled.

g To pause animation

1. Select the 3D model.

2. Press the 3D model’s menu arrow, and then select Animation > Play/Pause Animation.

g To resume playing animation

1. Select the 3D model.

2. Press the 3D model’s menu arrow, and then select Animation > Play/Pause Animation.

g To restart animation

1. Select the 3D model.

2. Press the 3D model’s menu arrow, and then select Animation > Restart Animation.
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Adding labels
You can use labels to highlight different components of a 3D model. Labels can be text, shapes or
other 2D objects.

g To add a label

1. Select the 3D model.

2. Right-click the 3D model where you want to connect the label, and then select Add Label.

A label appears.

3. To use text in the label, double-click the label’s default text and then type your own text.

OR

To use a shape or other 2D object in the label, create the object and then drag it into the label.

4. Optionally, drag the label’s connection point to a different location on the 3D model.

g To hide and display a label

1. Press the label’s connection point on the 3D model.

The label is hidden.

2. Press the label’s connection point to display the label.

g To remove a label

1. Select the label.

2. Press Close .
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Navigating 3D scenes
Large 3D models that contain internal details are called 3D scenes. You can navigate 3D scenes
using controls in SMART Notebook software.

NOTES

l You can use the navigation controls to navigate any 3D model. However, not all 3D models
contain internal details. If you enter a 3D model that doesn’t contain internal details, the
interior appears empty or dark.

l If you’re usingMac OS X operating system software, you’re unable to enter a 3D scene while
in Full Screenmode. To enter a 3D scene, first exit Full Screenmode and then complete the
following procedure.

g To navigate a 3D scene

1. Select a 3D model.

2. Press the 3D model’s menu arrow, and then select Enter 3D Scene.

SMART Notebook software displays the 3D scene in Full Screenmode. A map of the 3D
scene, navigation controls and the Close button appear.

T I PS

o You can press the gray border of themap to drag it to another area of the page if it’s
coveringmaterials you want to present. You can also resize themap by pressing and
dragging the gray border in the lower-right corner.

o You can press the gray background or center icon of a navigation control to drag it to
another area of the page if it’s coveringmaterials you want to present.
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3. Navigate the 3D scene using the navigation controls.

Button Use to:
A Change your orientation upward.
B Change your orientation to the left.
C Change your orientation to the right.
D Change your orientation downward.
E Raise elevation.
F Move forward in the scene.
G Move to the left in the scene.
H Move to the right in the scene.
I Move backward in the scene.
J Lower elevation.

Alternatively, you can use keyboard buttons to navigate the 3D scene.

Keyboard button Use to:
W Change your orientation upward.
A Change your orientation to the left.
D Change your orientation to the right.
S Change your orientation downward.
PAGE UP Raise elevation.
UP ARROW Move forward in the scene.
LEFT ARROW Move to the left in the scene.
RIGHT ARROW Move to the right in the scene.
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Keyboard button Use to:
DOWN ARROW Move backward in the scene.
PAGE DOWN Lower elevation.
ESC Close

NOTE

As you navigate the 3D scene, a red indicator in themap displays where you are in the scene
and the direction you are viewing. The arrow in the center indicates orientation. The arrow
becomes a circle when you’re facing directly up or down.

Level Incline Decline

Off-screen (level) Upward Downward

4. Press Close when you’re done.

Using Mixed Reality Tools
After inserting 3D models in your .notebook files using SMART Notebook 3D Tools, you can
manipulate thosemodels usingMixed Reality Tools.

Manipulating 3Dmodels usingMixed Reality Tools
Youmanipulate 3D models using your SMART Document Camera and themixed reality cube.

g To manipulate a 3D model using the mixed reality cube

1. Connect your SMART Document Camera to your computer and turn on the document camera.

2. Open the .notebook file, and then display the page containing the 3D model.
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3. Place themixed reality cube under the SMART Document Camera, showing one side of the
cube to the camera.

SMART Notebook software enters Mixed Reality mode and assigns the 3D model to the cube.
If there is more than one 3D model on the page, move the cube until the animation on the page
indicates that the cube is connected to the 3D model you want to manipulate.

NOTE

SMART Notebook software enters Mixed Reality mode in this situation only if a 3D model is
on the page. Alternatively, you can enter Mixed Reality mode by pressingSMART
Document Camera in the toolbar, and then pressingStart Mixed Reality in the
SMART Document Camera window.
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4. Do any of the following:

o Tomove the 3D model on the screen, move the cube.

o To rotate the 3D model on the screen, rotate the cube in your hand.

o To unassign the 3D model from the cube, cover the cube’s markings with your hand.

NOTE

If you experience any of the following symptoms, the causemay be issues with tracking:

o The 3D model doesn’t connect to the cube.

o The 3D model shakes when it’s connected to the cube.

o The 3D model sporadically disconnects from the cube.

o SMART Notebook software enters Mixed Reality mode when the cube is under the
camera even if you aren’t moving the cube.

To address tracking issues, see Lighting requirements on page 53.

T I PS

o As youmove and rotate the cube in your hand, ensure you don’t cover the symbols on
the cube’s surface.

o To hide the image from the SMART Document Camera and show only the 3D model,
move the transparency slider to the left.

5. If you’ve purchased a second cube from SMART and there is more than one 3D model on the
page, manipulate another 3D model by completing steps 3 and 4 with the other cube.

NOTE

The two cubes must have different patterns if you want to use them both at the same time.

6. When you’re done, move the cube (or cubes) away from the camera.

SMART Notebook software exits Mixed Reality mode after a few seconds.

Disguising 3Dmodels before presenting them
If you want to hide 3D models in your .notebook file before presenting them, you can use the Disguise
feature to hide the 3D models with amagic hat.

When you useMixed Reality Tools, themagic hat disappears after Mixed Reality Tools assigns the
3D model to the cube, revealing the 3D model.
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NOTE

If you hidemultiple 3D models on the same page with magic hats, eachmagic hat has a different
colored ribbon.

g To hide a 3D model with a magic hat

1. Select the 3D model.

2. Press the 3D model’s menu arrow, and then select Disguise > Disguised.

g To change the magic hat’s color

1. Select themagic hat.

2. Press themagic hat’s menu arrow, and then select Disguise > Change Color.

g To reveal a 3D model under a magic hat

UseMixed Reality Tools as described inManipulating 3D models usingMixed Reality Tools on page
62.

After Mixed Reality Tools assigns the 3D model to the cube, stars swirl around themagic hat, and
then themagic hat disappears, revealing the 3D model behind it.

T I P

You can also reveal the 3D model by pressing the hat icon in the lower-left corner.

Using SketchUp sketching software and
Google 3D Warehouse
Google offers two 3D tools that you can use with SMART Notebook 3D Tools andMixed Reality
Tools:

l SketchUp sketching software

l Google 3D Warehouse

Using SketchUp sketching software
You can use SketchUp sketching software to create 3D models. You can save these 3D models in
COLLADA (.dae) format and then insert them in SMART Notebook software.
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g To save a 3D model in .dae format

1. Open the 3D model in SketchUp sketching software.

2. Select File > Export > 3D Model.

TheExport Model dialog box appears.

3. Browse to where you want to save the file.

4. Type a name for the file in the File name box.

5. Select COLLADA File (*.dae) in theExport type drop-down list.

6. Press Export.

g To insert the 3D model in SMART Notebook software

See Inserting 3D models on page 56.

UsingGoogle 3DWarehouse
Google 3D Warehouse is an online repository of 3D models. TheGallery tab in SMART Notebook
software includes a link to Google 3D Warehouse. Using this link, you can search for 3D models and
download them to your computer. You can then insert the 3D models into your .notebook files.

g To download 3D models from Google 3D Warehouse

1. Press theGallery tab.

2. Press Google 3D Warehouse.

Google 3D Warehouse appears in the bottom section of the Gallery tab.

3. Search or browse for a 3D model that you want to download.

Select themodel.

4. Press Download Model, and then press theDownload link besideCollada (.zip).

NOTES

o When you first download a 3D model, Google 3D Warehouse could prompt you for a
nickname.

o If you’re usingMac OS X operating system software and you cancel the download, the
3D model still saves to theDownloads folder.

5. Save the .zip file to your computer.

6. Extract the contents of the .zip file to a folder on your computer.
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g To insert a 3D model downloaded from Google 3D Warehouse

See Inserting 3D models on page 56.
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Chapter 8: Troubleshooting
Document camera issues 69
SD Card view issues 70

This chapter includes troubleshooting information for your SMART Document Camera.

Document camera issues
Use the following table to troubleshoot issues with your document camera.

Issue Solution
No image displays. l Turn off your document camera (see page 22). Securely

connect all cables and connect the camera’s AC adapter to a
power outlet. Turn on your document camera.

l Adjust the zoom dial. The cameramay be on a blank section of
your document.

l Ensure the output switches on the side panel are set to the
proper image output:

o VGA DVI-D or Composite on the side panel

o NTSC or PAL on the bottom of your document camera

No image displays after you
restart your computer when
your document camera is
connected through a USB
hub.

1. Turn off your document camera, and then wait several
seconds.

2. Turn on your document camera again.

The image is out of focus.
l Press theAuto Focus button.
l Use themanual focus.

l Move the camera further away from the object.

The image is scrambled or
black and white when a
television is the display
device.

Ensure the NTSC/PAL switch on the bottom of the document camera
is set correctly. SeeSwitching between NTSC and PAL on page 15.
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Issue Solution
The image is too dark. l Press the brightness buttons on your document camera.

l If the object isn’t well lit, turn on your document camera LED.

l Adjust the shutter speed. SeeCamera view Image Settings
on-screen display menu on page 32.

The image is broken apart
by lines.

l Adjust the distance between the object and the camera.

l Adjust your projector settings.

SMART Notebook software
enters Mixed Reality mode
accidentally.

1. Press SMART Document Camera in the toolbar.

2. Press Additional Settings , and then clear the selection of
Automatically Start Mixed Reality Tools.

NOTE

To enable the automatic detection of Mixed Reality again, press
Additional Settings , and then select Automatically Start
Mixed Reality Tools.

SD Card view issues
Use the following table to troubleshoot issues with SD Card view.

Issue Solution

No image appears when you
press theSD Card view
button.

l Check the connection between your document camera and the
projector, television or display. SeeSetup configurations for
Camera view and SD Card view on page 11.

l Ensure your document camera, projector or television is turned
on.

A crossed out, red SD Card
icon appears when you
press theSD Card view
button.

Place a SD or SDHC memory card in your document camera SD
card slot.
OR
There are no images on thememory card.

The SD Card view menu
does not include
SD Settings .

In Camera view, set USB-B mode to Application. SeeSetting USB-B
Applicationmode on page 39.

Slideshow doesn’t start, and
there are images in the
memory card.

Your slideshow is set to Lock, and you don’t have any locked
images.
Set the slideshow to All. SeeSlideshow Settings on-screen display
menu on page 49.
OR
Lock some or all of the images in thememory card. See Locking and
unlocking images on page 46.
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Appendix A: Hardware environmental
compliance
SMART Technologies supports global efforts to ensure that electronic equipment is manufactured,
sold and disposed of in a safe and environmentally friendly manner.

Waste Electrical and Electronic Equipment
regulations (WEEE directive)
Waste Electrical and Electronic Equipment regulations apply to all electrical and electronic equipment
sold within the European Union.

When you dispose of any electrical or electronic equipment, including SMART Technologies
products, we strongly encourage you to properly recycle the electronic product when it has reached
the end of its life. If you require further information, please contact your reseller or
SMART Technologies for information on which recycling agency to contact.

Restriction of Certain Hazardous Substances
(RoHS directive)
This product meets the requirements of the European Union’s Restriction of Certain Hazardous
Substances (RoHS) directive 2002/95/EC.

Consequently, this product also complies with other regulations that have arisen in various
geographical areas, and that reference the European Union’s RoHS directive.

Packaging
Many countries have regulations restricting the use of certain heavy metals in product packaging. The
packaging used by SMART Technologies to ship products complies with applicable packaging laws.
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China’s Electronic Information Products
regulations
China regulates products that are classified as EIP (Electronic Information Products).
SMART Technologies products fall under this classification andmeet the requirements for China’s
EIP regulations.
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